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This guide provides information on service testing options of Integration Server usingwebMethods
Test Suite. The scope of this document is to introduce the suite, design and execute test cases.

It is assumed that the user is familiar with the standard build and test tools such as, Ant and JUnit.

Document Conventions

DescriptionConvention

Identifies elements on a screen.Bold

Identifies service names and locations in the format folder.subfolder.service, APIs,
Java classes, methods, properties.

Narrowfont

Identifies:Italic

Variables for which you must supply values specific to your own situation or
environment.
New terms the first time they occur in the text.
References to other documentation sources.

Identifies:Monospace font

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the
information inside the curly braces. Do not type the { } symbols.

{ }

Separates two mutually exclusive choices in a syntax line. Type one of these
choices. Do not type the | symbol.

|

Indicates one or more options. Type only the information inside the square
brackets. Do not type the [ ] symbols.

[ ]

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

...

Online Information and Support

Software AG Documentation Website

You can find documentation on the Software AG Documentation website at http://
documentation.softwareag.com. The site requires credentials for Software AG's Product Support
site Empower. If you do not have Empower credentials, you must use the TECHcommunity
website.
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Software AG Empower Product Support Website

If you do not yet have an account for Empower, send an email to empower@softwareag.comwith
your name, company, and company email address and request an account.

Once you have an account, you can open Support Incidents online via the eService section of
Empower at https://empower.softwareag.com/.

You can find product information on the Software AG Empower Product Support website at
https://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability, and download
products, go to Products.

To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, go to the Knowledge Center.

If you have any questions, you can find a local or toll-free number for your country in our Global
Support Contact Directory at https://empower.softwareag.com/public_directory.asp and give us
a call.

Software AG TECHcommunity

You can finddocumentation and other technical information on the SoftwareAGTECHcommunity
website at http://techcommunity.softwareag.com. You can:

Access product documentation, if you have TECHcommunity credentials. If you do not, you
will need to register and specify "Documentation" as an area of interest.

Access articles, code samples, demos, and tutorials.

Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.

Link to external websites that discuss open standards and web technology.
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Overview

Test Suite is an Eclipse based testing tool that allows developers to create unit tests for their
development. These tests improve the overall development quality and provide a mechanism to
create automated tools for continuous integration and delivery.

Test Suite provides the following functionalities:

Provides service unit testing and regression testing tools that allows service developers to
assemble unit tests without the need for additional development

Enables integration with JUnit to leverage a standard unit testing framework, which already
works well with Continuous Integration tools

Enables ease of use for test development

Provides a Java API for advanced users to create JUnit test cases

Provides a user interface that is integrated in Software AG Designer. Software AG Designer
ensures that users do not switch between tools for services development and corresponding
test cases

Provides a mechanism to repeatedly execute the service with same inputs and compare the
results with an expected set of outputs

Provides a framework for mocking service execution for steps that cannot be executed during
the testing. For details, see “Using Mocks ” on page 36

Terms and Concepts

This section provides information on the terms and concepts used to understand Test Suite.

Services
The webMethods Integration Server hosts packages that contain services and related files. The
server contains several packages.

For example, Packages that contain built-in services, which can be invoked from services or client
applications and services that demonstrate features of the webMethods Integration Platform.

You can create additional packages to hold the services that your developers create. Developers
can create services that perform functions, such as, integrating your business systems with those
of your partners, retrieving data from legacy systems, and accessing and updating databases.

Integration Server provides an environment for the orderly, efficient, and secure execution of
services. It decodes client requests, identifies the requested services, invokes the services, passes
data to them in the expected format, encodes the output produced by the services, and returns
output to the clients.
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Pipeline
Pipeline refers to the data structure in which input and output values are maintained for a flow
service. It allows services in the flow to share data.
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Pipeline starts with the input to the flow service and collects inputs and outputs from subsequent
services in the flow. The service in the flow has access to all data in the pipeline at that point.

Unit Testing
Test Suite uses the concepts of service execution, pipeline data, and the open source JUnit testing
framework to provide unit testing functionality for Integration Server Flow and Java services. Test
Suite provides the ability to create a suite of tests consisting of individual test cases. Each test case
defines a service to be tested, the type of test to be performed, and provides a user interface to
define input data to the test case through the pipeline. When the service execution is completed,
the pipeline output is validated against the expected output defined in the test case.

Test Case
A test case is a unit of testing for a service that provides:

service to be tested

inputs to the service

expected output from the service

A test case can also define expected output from a service as an exception or error. The service
returns the defined errors when incorrect data is sent to it.

Test Suite
A test suite is one or more test cases grouped together. Test suites are used to organize test cases
into sets of related tests. For example, a service may provide a variety of capabilities based upon
the inputs provided to it. A complete test suite should include test cases that provide inputs that
fully test all of the possible outputs of the service, including errors or exceptions.

Mock
Mocks provide a means of simulating interaction with resources that are unavailable or the data
provided by these resources or systems is not consistent for test purposes. Mocks also have a
lifetime that can either be limited to the test case in which they are defined or applied to all of the
test cases that follow within a test suite from the point of the definition.

Mock intercept can control the session, user, and server based on the scope setting. If the scope is
set to session, the test sessions will be affected by the mock. It is recommended to set the scope to
session for most users. If the scope is set to user, all the sessions for the particular user will be
affected by the mock. If the scope is set to server, all user sessions will be affected by the mock.
Mocks can be enabled or disabled for test case or test suite execution.
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Service Mock
A service mock is used to replace the call to a service with a call to a different service. Any call to
the mocked service is intercepted and the alternate service defined in the mock is called instead.
The output of themocked service is then returned to the calling service. This kind ofmock is useful
when the output of the mocked service needs to be dynamic based on some logic that can be
created in the service.

Exception Mock
An exception mock is used to return an error or exception to the calling service and can be useful
for testing error handling in a service. As with the other mocks described, any call to the service
defined in the mock is intercepted and the exception defined in the mock is returned instead. This
kind of mock is useful to simulate behavior that can cause exceptions in the normal flow.

Factory Mock
A factory mock is used when a call to a service produce multiple different outputs based on the
provided input. A factory mock is implemented as a Java class. Any call to the class defined in a
factory mock is intercepted and the input is passed to the factory which evaluates the input and
returns the appropriate results.While both the factorymock and the servicemock options provide
dynamic output simulation, the factory mock does not require an extra test service to be created
on the server and relies on a lightweight java implementation.

Capabilities

Test Suite has following capabilities:

Unit testing

Mock testing

Regression testing

Code coverage

Unit testing

Test Suite is a unit-testing tool. You can design, build, and execute unit test cases using Eclipse
User Interface. You can also execute the test cases externally using Ant scripts.

Mock testing

Mocking is a feature that mimics the functionality of services that are dependent on external
resources. When a test case encounters a service that is mocked, it executes the service.
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Regression testing

You can save the test cases, along with their inputs and outputs, in xml files. Run the reusable
artifacts to ensure that the latest changes do not reintroduce the errors fixed in the earlier versions.

Code coverage

Unit Test Framework records and analyzes the flow steps and map actions of your flow service(s)
that are executed during a test launch. It helps you to identify the untested steps and improve the
corresponding tests.

Server Definition

Integration Server preferences in Designer describe the connection to Test Suite.

Designer always uses the active default Integration Server definition for Test Suite. Secure
connection option in default server definition indicateswhether the sessionwill be opened through
HTTP or HTTPS. In Designer, navigate to Window > Preferences > Software AG > Integration
Server to add, edit, and update connection configurations. For details, see webMethods Service
Development Help.

Unit Test Framework can also connect to a remote Integration Server through a proxy server. In
Designer, navigate to Window > Preferences > General > Network Connections to provide the
proxy server's settings.

The editor does not always require an active connection to test development. But some of the
introspection features that allow service lookup and service signature are not available if a
connection is not available and so, the user should enter them manually.

Environment

DescriptionOption

No additional hardware is required other than the ones that are already in
use for Integration Server and Software AG Designer.

Hardware
Requirements

Software
Requirements

Developer Installation Requirements

Unit Test Framework Eclipse plug-in (Designer > Services > Unit Test
Framework)

WmServiceMock package for Integration Server (Integration Server or
Microservices Runtime Packages > Unit Test Framework)

Unit Test Framework SoftwareAGDesigner plug-in canworkwith both Local
and Remote Integration Server.

Continuous Integration Installation Requirements

14 webMethods Unit Test Framework Help 10.5

1 Unit Test Framework



DescriptionOption

WmServiceMock package for Integration Server (Integration Server or
Microservices Runtime Packages > Unit Test Framework)

Unit Test Framework libraries (Infrastructure > Libraries > Unit Test
Framework Libraries)

Ant Build tool 1.7 (optional)

JDK 1.8 or later

This suite depends on open source products like Ant and JUnit.Version
Compatibilities

Following are the supported versions:

Ant: 1.7

JUnit: 4.11

Unit Test Framework works with all the currently supported General
Availability (GA) versions of Integration Server and Software AG Designer.

What it is not

Test Suite is not an integration or system test platform. However, this suite is used to mock
the application dependencies and simulate the integration or system test.

Test Suite is not a performance-testing tool. It cannot be used for performance, load, or volume
testing.
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Opening the Unit Test Framework Perspective

SoftwareAGDesigner provides aUnit Test Framework perspective that contains the views, editors,
and tabs needed to build test suites and other supporting elements.

1. In Designer, select Windows > Open Perspective > Other.

2. In the Open Perspective dialog box, select Unit Test Framework and click OK.

Designer switches to Unit Test Framework perspective.

Layout

The figure below shows various components of Software AG Designer with a test suite file open
for editing.

Use the following icons on the toolbar to tailor the layout.

DescriptionIcon

Allows you to place the Master and Details views next to each other, master
on the right and details on the left.

Allows you make the master appear at the top of the display, and the details
view gets aligned underneath it.

Allows you to toggle the display between the master and details views, each
occupying the entire display. Click again to return to the original layout .
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Test Suite Preferences

To display the preferences dialog box, select Window>Preferences>Sotware AG>webMethods
TestSuite.

Advanced
The Advanced preferences control other behaviors of Test Suite.

DescriptionPreference

Makes file name references relative to the Eclipse project containing the test
suite rather than using the full path. Using relative names helps in executing

Use Relative
Paths in
Filenames tests when the test suite and data files are moved between environments and

systems. This option is enabled by default.

Controls the display of the field that allows the selection of the comparator
and does not allow/disallow this during execution.

Allow Comparator
Configuration

Enables the option of creating client side factory object that do not need to be
deployed on the server before executing test cases. This option controls the

Allow client side
mock factory
objects display of the field that controls whether the mock factory objects are needed

on the server or can be pushed during the execution of the tests.

Enables additional fields in the Expected Output section of a test case. This
option is useful if you want to check several output conditions together.

Display all fields
in the expression
editor

Enables editing of the XML source for the test suite. This option requires that
the open test suite file is closed and reopened before its behavior reflects in
the editor.

Allow editing of
XML (Effective
after reopen)

Enables scope selection for the mock. The default setting of unchecked is
appropriate for most test case scenarios.

Allow scope
selection for
mocks

Enables the display of a confirmation dialog box for every mock service or
data entry delete.

Confirm delete of
single objects

Enables the display of a confirmation dialog box when you delete multiple
mock service or data entries.

Confirm delete of
multiple objects

Enables the display of a confirmationdialog boxwhen youpaste a test services.Confirm service
paste

Code Coverage
The advanced code coverage preferences controls the behaviors of code coverage execution in
Test Suite.
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DescriptionPreference

Generates an additional Execution Model report during code coverage
execution in Test Suite.

Include Execution
Model Report in
Code Coverage
Execution

Generates an additional Service Level Coverage report during code coverage
execution in Test Suite.

Include Service
Level Covergae
Report in Code
Coverage
Execution

Enables you to debug a Java code during the code coverage execution in Test
Suite.

Include Launch
Code Coverage
Execution in
Debug Mode

License
The License preferences provide the license related information of Test Suite.

DescriptionPreference

Allows you to select the license file for Test Suite.License file

Allows you to check the validity of the license file.Check License

Editor
The Editor preference allows you to list the packages to load tot he service browser. connection
to webMethods Integration Server.

DescriptionPreference

Optional. Allows you to optionally enter a comma-separated list of packages
for Test Suite to load to the service browser.When a large number of packages

Package Filter

exist on the Integration Server, this feature loads only those services for which
test cases are developed and thereby conserves memory in Test Suite.

Validation
The Validation preferences describe when and how Test Suite should validate the information
that you enter.
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DescriptionPreference

Allows Test Suite to validate the test suite prior to saving it to the file system.
This option is enabled by default.

Validate on Save

Allows Test Suite to perform validation of the test suite prior to switching
from the XML editor mode to the test suite editor.

Validate before
switching mode

Allows Test Suite to validate the test suite against the XML schema. This is
useful if you use the XML Source tab to enter details of one or more test cases
in the suite. This option is enabled by default.

Validate against
schema
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Before You Begin

Before creating a test suite, ensure that you organize the required test cases and data files in a test
folder.

If the test cases are packaged in the Integration Server package, it provides a common source
location for all related assets. You can import the package on eclipse workspace.

Example: Consider that the test cases are created in the resources test folder of the Integration
Server package.

While any organizational structure that conforms to Integration Server package structure can be
used, the following example provides a useful approach for organizing test cases in your
environment. For ease of organization, follow the steps below:

1. Right click the Resources directory and create a subdirectory under it called test.

2. Right-click the test directory and create two additional folders data and setup.

3. Add the test suites to the setup directory and organize the data directory using subdirectories
for each test suite to contain the input data files for the test cases comprising a test suite.

To Create a Test Suite

Follow the below steps to create a test suite:

1. Navigate to resources> test> setup folder.

2. Select File>New> Test Suite.

3. On the webMethods TestSuite screen, enter the folder path that contains the test suite setup
files, provide a file name, and a suite name.

4. Click Finish.

You can now start creating the test cases.

Creating a Sample Test Suite

Designer allows you to create sample Test Suite projects.

1. Navigate to resources> test> setup folder.

2. Select File>New> Test Suite Example.

3. On the Sample wmTestSuite Project screen, enter the project name and location. You can
choose to use the default values.
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This Test Suite familiarises you on building test cases.
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Adding a Test Case

Adding a test case involves the following steps:

1. Adding required test details. See “Test Details” on page 28.

2. Adding the required service details. See “Service Details” on page 28.

3. Defining inputs to services. See “Inputs” on page 28.

4. Defining the expected output. See “Expected Output” on page 29.

Test Details

To add test cases:

Right click on the webMethods Test Suite section.

The Test Details section appears in the details area to the right side of the display. Provide a
name and description for the test case.

Service Details

After creating the test details, you can now select the service to be tested.

1. Click Browse in the Service Details section to enable searching for the service within the
Integration Server.

Note:
You can narrow the search by entering a package name or service name and the service
browser will restrict the display to only those packages or services matching the search
criteria entered.

2. Click to refresh or set additional options for service browser.

Inputs

Test Suite looks at the service signature for services in the Integration Server. When defining the
inputs to the service selected in “Service Details” on page 28

Click Edit to modify the values of the input parameters and click OK to save the changes.

Click Save... to save the file in the location designated for the input data after defining the
input.

Click Load to import a saved input data.

Click Browse to add a saved file as the input to the service.
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Expected Output

The final step in defining a test case is to complete the Expected Output section. Expected Output
can be in the form of data returned from the service or an exception returned from the service.

Use the class browser to define an exception or error output from the service. Click Browse to
display the classes and select the proper exception class to use.

To define the data output from the service, use the following methods:

Use XPath expressions to define which data elements in the output data should be evaluated.

1. Copy the XPath expressions from Software AG Designer. To copy the XPath expression,
right click on the variable in the Results area when executing the service within Software
AG Designer and select Copy.

2. Click , , or and paste the copied value into the XPath field.

An entry for the variable selected is created. However, it in most cases it is not required to
edit them as the webMethods paths are 0 index based whereas XPath expressions are 1
index based.

3. Enter the expected output for the field in the Value field.

You can select AND, OR, parentheses, and operators from the drop-down lists to create
complex evaluations of the output.

Use regular expressions to evaluate the output returned from the service. The regular expression
should be placed in the Value field preceded and followed by "/" character.

Output Comparison

Unit Test Framework allows you to select predefined or customize the output comparison to
compare service results and check the destination table to confirm the operation executed
successfully.

Prerequisite

For the Output Comparison section to appear on the webMethods TestSuite screen, ensure
that you select the Display all comparators option on the Preferences dialog box. To select
Allow Comparator Configuration, navigate to Window > Preferences > Sotware AG >
webMethods TestSuite > Advanced.

1. On the Output Comparison section, select Comparator Type.

2. Select one of the following options:
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To...Select...

Compare the actual and expected service result without any
filter.

Default

Ignore the namespace prefix from the service results.Ignore Namespace
Prefix

For example, for a field value demotest:employee in the actual
result, where demotest is the namespace prefix, Unit Test
Framework ignores the namespace and uses employee for
comparison.

Specifywhich fields in the service result should be compared.Use Field Alias

You have to provide a field alias for the field in the actual
result that you want to Unit Test Framework to compare
against in the expected output.

For example, for a field value demotest:employee in the actual
result, you can assign a 1002 as the field alias. Then, Unit Test
Framework uses 1002 instead of demotest:employee for
comparison.

Click to add the list of fields to compare.

Click , or to edit or delete the entries.

Specify a custom comparator for expected output other than
provided with the plug-in.

Custom
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Generating Tests Suites using Service Execution Results

Test Suite allows you to generate tests from the details of recently run services present in the Result

view. Using the Generate Test icon on the Results view, you can export the available service
invoke or run details to form a unit test and save in a Test Suite.

Ensure that you have installed the Test Suite Designer plugin.

1. In the Service Development perspective, navigate to the Results view of recently run services
and select the service for which you want to generate a test.

Note:
For details on viewing the Results view, see the Software AG Designer Online Help.

2. Click .

3. In the Export Pipeline dialog box, provide the following details and click Finish.

FunctionType

Specifies the project or directory location of the Test Suite.Container

Ensure that you use an organizational structure that
conforms to Integration Server package structure.

Ensure that the specified project exists in the workspace.

Specifies the name of the TestSuite file.TestSuite

Use Overwrite to rebuilt the Test Suite. This overwrites the
existing Test Suite.

Use Append to append to the existing Test Suite.

Note:
Ensure that you provide the filenamewith the extension.
For example, wmTestSuite.xml.

Specifies the service input file location.Input

Note:
You can choose to retain the default value.

Specifies the expected output file location.Output

Note:
You can choose to retain the default value.

The Test Suite is created at the specified location.
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4. Double click the newly created Test Suite.

The test details are displayed. You can edit the test details. To edit the test details, see .
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Using Mocks

Mocks are usedwhen resources that a servicemay require to properly executemay not be available
when a test case or test suite is developed or executed. Mocks provide a means of simulating
interaction with resources that are unavailable.

To create a mock

1. Expand the test case for which you want to define the mock, right click on Mocks and select
Add.

2. Click Browse and use the Service Browser to select the service to be mocked.

3. Enter the first few characters of the service name to reduce the list. Click to refresh the list and
access preferences for the Service Browser.

4. Select the required Lifetime.

Valid selections are test (mock is effective only for the selected test case) and suite (mock will
be effective for all of the test cases that follow in the test suite).

5. Select the required Type.

Following are the valid selections:

FunctionType

Intercepts the service and returns the specified pipeline (for
details on creating or editing pipeline data see “Inputs” on
page 28).

pipeline

Intercepts the service and substitutes the selected servicewith
a call (for details on working with the Service Browser, see
“Service Details” on page 28).

service

Intercepts the service and returns an exception (for details on
selecting exception classes, see “Expected Output” on
page 29).

exception

Intercepts a call to the mocked service and returns the data
based on the input (for details on creating a mock factory, see
“Sample Mock Factory” on page 37).

factory

6. Select the scope.

It is recommended to use the session scope for most purposes. To allow the scope selection,
select the corresponding preference.
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Sample Mock Factory

The following code snippet illustrates the minimum requirements for creating a mock factory.
The factory class and any other classes should be designed to evaluate the input data to the factory
and return data relevant to that input in an IData format. The example below returns static data.
package com.wm.ps.serviceMock.samples;
import com.wm.app.b2b.server.BaseService;
import com.wm.app.b2b.server.invoke.ServiceStatus;
import com.wm.data.IData;
import com.wm.data.IDataFactory;
import com.wm.ps.serviceMock.MockDataFactory;
public class SampleMockDataFactory implements MockDataFactory
{
private static final long serialVersionUID = 2L;

public IData createData(BaseService baseService, IData pipeline,
ServiceStatus serviceStatus)
{

IData[] results = new IData[]{IDataFactory.create(new Object[][]{
{"originationSource","W"},
{"bizType","RT"},
{"lockExpirationDate","20050427"},
{"floatLoanIndicator","Y"},
{"uwFinalDecisionCode","0"},
{"uwDecisionExpiryDate","20050427"},
{"canDate","20050427"},
{"loanCloseStatusType","T"},
{"fileReceivedAtRocDate","20050221"},
{"loanReadyToFundIndicator","P"},
{"regisDate","20051221"},
{"loanSubmitToUwDate","20050427"},
{"loanNumber","0000000001"},
{"branch","TOTAL ADVANTEDGE LLC "},
{"underwritingDecisionCode","0"},
{"underwritingDecisionExpirationDate","20050427"},
{"lockDate","20051220"},
{"lockIndicator","Y"},
{"tmoLoanStageCode","3"},
{"tmoLoanStageDate","20050427"},
{"product","C30 "},
{"borrowerFirstName",". "},
{"borrowerLastName","XX "},
{"propertyAddress","937 S MEYER "},
{"propertyCity","TUCSON "},
{"propertyState","AZ"},
{"propertyZip","85701"}

})};

IData output = IDataFactory.create(new Object[][]{{"results", results}});
return IDataFactory.create(new Object[][]{{"getPotentialDuplicatesOutput",
output}});

}
}
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Mocks beyond Unit Testing

Although Test Suite added the ability to mock service calls in Integration Server for unit testing,
the feature is so powerful that its use cannot be limited to unit testing alone. One common case is
to use the mocking capability to provide flow service instrumentation.

Using the wm.ps.serviceMock:loadMock service in the WmServiceMock package, any service can be
mocked with an alternate service or class. The new service or Java class code can invoke any
operations and then invoke the original mocked service. The mocking framework is intelligent
enough to detect recursion and, as such, provides an instrumentation capability.

Mocks can be used to design test cases. A service being tested can also itself be mockedwith other
code. In such a scenario, the mocked test service can be replaced with other code that can execute
pre and post-test operations. This can provide some basic functional testing capabilities for Test
Suite.
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Pipeline Filter

The execution of test cases is initiated as a client to the Integration Server hosting the services to
be tested. For this reason, the inputs supplied to the service during execution and the expected
outputs need to be serialized over the client-server interaction. If the input or output pipeline
contains non-serializable objects, these objects are either lost or seen incorrectly during test
execution. In addition, the service input needs to bemore dynamic in nature than the static pipeline
setup in the test case. Pipeline Filter helps to resolve these issues.

The Pipeline Filter is set once for the entire suite and provides a callback mechanism for the test
developer to inject code that can modify various pipeline objects during execution. The Pipeline
Filter is a class that implements the com.wm.ps.test.PipelineFilter interface and enables a user to add,
remove, or change variables in the pipeline that are created from files, as pipelines created from
files may not be able to persist custom java objects. The output pipeline from a service can also be
filtered using the appropriatemethod. Only one such instance of the implementing class is created
for the test suite and the name of test case is passed as a parameter.

The pipeline filter can be setup for the test suite in the main panel for the suite parameters.

Comparators

Comparator provides an extension that can be used to extend, enhance, or replace the standard
comparison of expected output.

Each test suite can have its comparator that can be specified from the user interface.

Custom comparators are Java classes that implement the com.wm.ps.test.ResultsValidator interface.

Comparators also provide a mechanism to execute operations pre and post service execution.
Using comparators you can build some basic functional testing capability. For example, if a service
writes to a database table, a comparator can compare the results from the service and check the
destination table to confirm the operation executed successfully. You can also specify filters while
comparing.

Client Mock Factory

The benefit of using a mock factory object as opposed to a service is that it provides a light-weight
alternative that does not require the creation of a new service on the server.

Test Suite provides an option to dynamically push the classes needed for supporting the mock
factory on the server during test execution. This option can be used to avoid the need for frequent
restart when Java objects are changing. Once stabilized, it would be helpful to deploy the code to
the server as this feature is experimental in nature and will only work if the dependency tree is
not too complex. Using the user interface, you can set the option to dynamically push the objects
to the server.

If the option is disabled, enable the corresponding preference as discussed in theAdvanced section.
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JXPath equivalentwebMethods expression

PosRequest[@name='ns:Log'][@name='ns:Transaction'][1][@name='@Flag']PosRequest/ns:Log/ns:Transaction[0]/@Flag

PosRequest[@name='ns:Log'][@name='ns:Transaction'][1][@name='ns:BUnit'][1][@name='ns:ID'][@name='*body']PosRequest/ns:Log/ns:Transaction[0]/ns:BUnit[0]/ns:ID/*body

XPath Expressions

The XPath expressions used in the expected output panel are different from the usualwebMethods
path expressions. As mentioned in the “Expected Output” on page 29 section, the indices start at
1 instead of the 0 based webMethods indices.

Test Suite uses JXPath for evaluating XPath expressions. For details on JXPath expressions, visit
http://commons.apache.org/jxpath/. Special characters such as '@' and ':' in the name have special
meaning in JXPath expressions hence, you should use special syntax variant to use these characters
in variable name.
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Test Suite Internals

In Software AG Designer, test suite editor provides a user interface to graphically and quickly
develop test cases for Integration Server services. The test suite and the test cases are saved in an
XML file. The Software AGDesigner editor allows editing the XML source directly, provided that
the user is aware of the format and the associated schema.

It is not recommended to edit the XML file as it is error-prone. It provides the option to automate
the creation of test cases automatically by using code to generate the XML file directly. One such
use case is the scenario where service inputs and outputs have been captured in an environment
and test cases have to be generated to use these files for regression testing.

A sample XML test suite file in its simplified form can be as shown in the figure below:
<?xml version="1.0" encoding="UTF-8"?>
<webMethodsTestSuite description=
"Sample tests for the WmServiceMockSamples implementation" name="Sample Tests">

<webMethodsTestCase description=
"Duplicate Check Success with IData results" name="Duplicate Check Success
With Results">

<mock folder="wmServiceMockSamples.data.services"
name="getPotentialDuplicates">

<pipeline filename="resources/test/data/
mockDupCheckOutputResults.xml"/>

</mock>
<service folder="wmServiceMockSamples.services" name="getDuplicateLoans">

<input>
<file filename="resources/test/data/dupCheckInput.xml"/>

</input>
<expected>

<file filename="resources/test/data/
dupCheckSuccessWithResults.xml"/>

</expected>
</service>

</webMethodsTestCase>
<webMethodsTestCase description=

"Duplicate Check Failure handled by the catch block" name="Duplicate Check
Catch Block">

<mock folder="wmServiceMockSamples.data.services"
name="getPotentialDuplicates">

<exception class="java.lang.IllegalArgumentException"
message="Bad argument"/>

</mock>
<service folder="wmServiceMockSamples.services" name="getDuplicateLoans">

<input>
<file filename="resources/test/data/dupCheckInput.xml"/>

</input>
<expected>

<exception class="java.lang.IllegalArgumentException"
message="Bad argument"/>

</expected>
</service>

</webMethodsTestCase>
</webMethodsTestSuite>
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Java Unit Tests

Test Suite Java API allows you to create pure JUnit test cases that can provide the same features
that a user interface driven codeless test cases do.

The change when creating a Test Suite JUnit test case from the traditional test case is that the
implementing class extends com.wm.ps.test.WmTestCase instead of junit.framework.TestCase.
com.wm.ps.test.WmTestCase does extend the junit.framework.TestCase. The two important methods that
are needed for creating test cases using the java API are:

invokeService – The method to invoke a service on the server

mockService – There are various variants of this method that allow the user to setup a mock
for a service on the server.

A sample JUnit test case is provided here:
package com.wm.ps.serviceMock.samples;
import com.wm.data.*;
import com.wm.ps.test.*;
public class DuplicateCheckTest extends WmTestCase
{
public void testDupCheckCatchBlock() throws Exception
{

IData input = IDataFactory.create(new Object[][]{
{"lienType", "1"},
{"borrowerSSN", "111-11-1111"},
{"propertyAddress", "937 S Meyer"},
{"propertyZip", "85701"}
});

String exceptionText = "Bad argument";
mockService("wmServiceMockSamples.data.services",
"getPotentialDuplicates", new

IllegalArgumentException(exceptionText));
try
{

invokeService("wmServiceMockSamples.services",
"getDuplicateLoans", input);
assertFalse(true); //Control getting here means failure

}
catch (Exception e)
{

assertTrue(e.getMessage().endsWith(exceptionText));
}

}
public void testDupCheckSucessWithResults() throws Exception
{

IData input = IDataFactory.create(new Object[][]{
{"lienType", "1"},
{"borrowerSSN", "111-11-1111"},
{"propertyAddress", "937 S Meyer"},
{"propertyZip", "85701"}
});

IData mockOutput =
WmTestSuiteUtils.getIDataFromFile("resources/test/data/
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mockDupCheckOutputResults.xml");
mockService("wmServiceMockSamples.data.services", "getPotentialDuplicates",
mockOutput);
IData output = invokeService("wmServiceMockSamples.services",
"getDuplicateLoans",
input);

IDataCursor outCursor = output.getCursor();
IData response = IDataUtil.getIData(outCursor, "response");
IDataCursor responseCursor = response.getCursor();
String creationTime = IDataUtil.getString(responseCursor, "@creationTime");
assertNotNull(creationTime);
assertEquals(28, creationTime.length());
IData[] duplicateLoans = IDataUtil.getIDataArray(responseCursor,
"duplicateLoans");

assertEquals(duplicateLoans.length, 1);
}

}
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Executing Test Cases

To execute test cases createdwith Test Suite, right click in the webMethods Tests section and select
one of the following options:

Run Tests - executes the selected test case, using the mocks that are defined for the test case.

Run Test with Mocks Disabled - executes the selected test case by disabling themocks defined
for the test case.

Disable Test - marks test case as disabled. Tests are not executed until it is enabled again.

Disable Mocking in Tests - marks mocks defined for selected test as disabled. Mocks are not
executed until they are enabled again.

Add - adds another test case to the suite.

Insert - inserts another test case to the suite after the selected test case.

Remove - removes the selected test case from the suite.

Executing Test Suites

To execute test suites created using Test Suite, right click in the webMethods Tests section and
select one of the following options:

Run Suite - executes the selected test suite, using the mocks that are defined for the test suite.

Run Suite with Mocks Disabled- executes the selected test suite by disabling the mocks
de-fined for the test suite.

Disable Suite - marks test suite as disabled. The test suite is not executed until it is enabled
again.

Disable Mocking in Suite - marks mocks defined for this suite as disabled. Mocks are not
executed until they are enabled again.

Shift Up or Shift Down - changes the order of test cases in the test suite by shifting the selected
test case up or down in the test suite.

Debugging Java Code

Various components in Test Suite rely on Java code.

Example: Java mock factory and pipeline filter classes.

Use the Debug menu to debug a Java code. The support library jar files also have source code
associated with them. Debugging into the source can be helpful to understand the internals of the
test execution or to enhance capabilities new features like custom comparators.
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Continuous Integration

Software AG Designer allows you to create a Test Suite Executor project which provides a default
Ant script (run-composite-runner.xml) to start with continuous integration setup. When you
execute the Ant script, it invokes the Test Suite projects in headless mode. After the successful
execution, the script generates the test reports and code coverage reports. You can use the Jenkins
JUnit and HTML Publisher plugins to view these reports in Jenkins.

Creating a Test Suite Executor
SoftwareAGDesigner allows you to create Test Suite executor projects and execute tests in headless
mode.

Perform the following steps to create a sample test suite executor using the default files.

1. Select File>New> Test Suite Executor.

2. On the Test Suite Executor Project screen, enter the project name, folder path that contains
the test suite setup files, and the file system. You can choose to use the default values.

3. Click Finish.

Project contains default Ant build targets and properties to drive the tests.

Configuring a Test Suite Executor
Software AG Designer allows you to configure Test Suite Executor after you have successfully
created the projects.

Perform the following steps to configure a sample test suite using the default files.

1. To initiate the tests, use the ant build file, run-composite-runner.xml and ant target,
composite-runner-all-tests.

2. Modify the properties file, run-test-suites.properties to specify project locations and setting
up target Integration Server definition.

3. Specify the following properties in the run-test-suites.properties file.

Server Information

DescriptionName

Specifies the Integration Server host name.webMethods.integrationServer.name

For example: localhost, 127.0.0.1

Specifies the Integration Server port.webMethods.integrationServer.port
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DescriptionName

For example: 5555

Specifies the Integration Server user name.webMethods.integrationServer.userid

For example: Administrator, Developer

Specifies the Integration Server user password.webMethods.integrationServer.password

For example: manage

Specifies the Integration Server port uses SSL
connection or normal.

webMethods.integrationServer.ssl

For example: false or true

Specifies the hostname or the IP address of a
proxy server.

watt.net.proxyHost

For example:
watt.net.proxyHost=webcache.example.com

Specifies the port number of the proxy server.
The default value is 80.

watt.net.proxyPort

For example: watt.net.proxyPort=8080

Specifies the name of a user account on the
proxy server.

watt.net.proxyUser

Specifies the password for the username set
using watt.net.proxyUser.

watt.net.proxyPass

Specifies the hostname or the IP address of the
proxy server to be used in SSL connections.

watt.net.secureProxyHost

For example:
watt.net.secureProxyHost=webcache.example.com

Specifies the port number of a proxy server to
be used in SSL connections.

watt.net.secureProxyPort

For example: watt.net.secureProxyPort=443

Specifies the name of a user account on the
proxy server.

watt.net.secureProxyUser

Specifies the password for the username set
using watt.net.secureProxyUser.

watt.net.secureProxyPass

Specifies the list of hosts that should be
accessed directly, bypassing the proxy. This

http.nonProxyHosts
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DescriptionName

is a pattern separated by '|' character, which
can also have * for wildcards.

Any host matching one of these patterns is
accessed through direct connection, bypassing
the proxy.

For example:
http.nonProxyHosts=”.foo.com|localhost|127.*|[::1]”
indicates that every host in the foo.com
domain and localhost should be accessed
directly even if a proxy server is specified.

Project Information

DescriptionName

Specifies the product installation location.webMethods.home

For example: C\:\\SoftwareAG

Specifies multiple project locations (absolute
directory path) in

webMethods.test.setup.location

$AbsoluteProjectLocation1,\

$AbsoluteProjectLocation2,\

$AbsoluteProjectLocation3

format. In this case, a Test Suite Executor
searches for all available and valid Test Suite
files in these directories.

For example:

C:/SoftwareAG/IntegrationServer/instances/
default/packages/SampleTestSuite,\,.

C:/_gitRepo/packages/SampleTestSuite1

It executes specific and multiple Test Suite
files by specifying it in the following format:

$AbsoluteProjectLocation1;

$RelativeTestSuitePath1,\

$AbsoluteProjectLocation2;

$RelativeTestSuitePath2
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DescriptionName

For example :

C:/SoftwareAG/IntegrationServer/instances/
default/packages/
SampleTestSuite;resources/test/setup/
wmTestSuite.xml,\

C:/_gitRepo/packages/
SampleTestSuite1;resources/test/setup/
wmTestSuite.xml

Specifies the relative paths within the projects
where the required classes or jar files are

webMethods.test.setup.external.classpath.layout

expected to be present in a Test Suite Executor
project build-classpath. For example, when
third-party libraries or Mockfactory classes
are referred from the Tests, specify the
locations where these are stored at, so that
executor can load these dependencies during
headless tests. Append the default comma
separated list if required.

Default value:

resources/test/classes,resources/java/
classes,resources/test/jars,resources/
java/jars,resources/jars

Specifies the absolute directory locationwhere
the reports are stored.

webMethods.test.profile.result.location

For example:

C:/git_sources/GitRepo3/
WmTestSuiteExecutor/test/reports/

Note:
Alternatively, you can also use the ant build file run-test-suites.xml and target runall-
test. Test Suite Executor cleans and builds the projects included in target runall-test, then
searches for the TestSuites and executes. List of projects can be includedwithin runall-test
target (under dirset contents). Reports are generated at the following default location:
$basedir/test/reports. To use runall-test, the test projects or packages has to conform to
the default project layout. Refer to the SampleTestSuite for the default project layout.

Important:
It is recommended not to customize the code coverage report resources and the Ant build
file artifacts of the Test Suite Executor project directly, Instead:
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Import the available Ant targets in use to any newAnt build files and reuse them,which
prevents any conflicts during the migration of the Test Suite Executor project artifacts
to the latest fixes or new releases.
Keep the Test Suite Executor artifacts in sync with the fix or release version of the
product in use to avoid compatibility issues.
Recreate the Test Suite Executor project in Designer, which distributes compatible
resources.

View JUnit Test Results and Code Coverage Reports

When you execute theAnt script (run-composite-runner.xml) from the Test Suite Executor project,
the build process generates the JUnit reports and code coverage reports. You can find these reports
in the folder defined by the webMethods.test.profile.result.location property in the run-test-
suites.properties file.

View JUnit reports

TheAnt script invokes the headless test execution buildwhich generates JUnit reports in XML and
HTML formats.

Then...When the JUnit report is...

The Ant script invokes the headless test execution build which
generates the XML report in the location as defined by the

XML

webMethods.test.profile.result.location property in the run-
test-suites.properties file.

Use the JUnit test report extension of your continuous integration
tool to view the test report. For example, the Jenkins JUnit plugin.
This plugin provides a graphical representation of the historical
test results and a web interface to view test reports and track
failures.

The Ant script invokes the headless test execution build which
creates the html folder containing a HTML report. The build

HTML

process creates the html folder in the location as defined by the
webMethods.test.profile.result.location property in the
runtest-suites.properties file.

Use a plugin supported by your continuous integration tool to
publish the test report. For example, the Jenkins HTML Publisher.

View code coverage report

The Ant script invokes the headless test execution build which generates the code coverage report
when the webMethods.test.setup.profile.mode property is set to Coverage in the run-
testsuites.properties file.
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The build process generates the wmcodecoverage folder in the same location as defined by the
webMethods.test.profile.result.location property in the run-test-suites.properties file and
saves the code coverage report inside the wmcodecoverage folder.

To publish the code coverage report, you can use a plugin supported by your continuous integration
tool. For example, the Jenkins HTML Publisher. You can use any supported application server to
view the code coverage reports in your web browser. For example, NodeJs or Tomcat. To view
the report, you must copy the wmcodecoverage folder to the application server.
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Running a Coverage Analysis

Unit Test Framework allows you to record and analyze which flow steps and map actions of your
flow service(s) are executed during a particular test launch. It helps to identify untested steps and
improve the corresponding tests.

Pre-requisites:

Before running the test coverage analysis, activate thewMCodeCoverageAgent. You can activate
the wM Code Coverage Agent either through Designer or Integration Server startup script or
Microservices Runtime startup script.

Through Designer

Perform one of the following steps to activate the wM Code Coverage Agent:

On the Package Navigator, right-click the default Integration Server instance, and select
wM Code Coverage Agent > Activate.

OR

1. In Designer, navigate toWindow > Preferences > Software AG > Integration Server,
and select the default server.

2. Click wM Code Coverage Agent.

3. On the wM Code Coverage Agent Settings dialog, select Activate.

Through the Integration Server startup script or Microservices Runtime startup script.

Perform one of the following steps to activate the wM Code Coverage Agent:

Integration Server

If Integration Server launches using the Tanuki Java service wrapper in the startup
script, configure the Java agent in custom_ wrapper.cnf as follows:
wrapper.java.additional.400=-javaagent:$IntegrationServer_packages_location/WmServiceMock/
resources/int/utf-agent.jar=log=level=INFO.

Replace $IntegrationServer_packages_locationwith the absolute path of Integration
Server packages.

Note:
Software AG recommends that any new custom properties added to
custom_wrapper.conf be assigned a number of 400 or higher to prevent conflicts
with properties added by Software AG.

If Integration Server launcheswithout using awrapper, configure the Java agent settings
in the Integration Server_directory/bin/setenv.bat(sh) file as follows:
JAVA_OPTS="-javaagent: $IntegrationServer_packages_location /WmServiceMock
/resources/int/utf-agent.jar=log=level=INFO".
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Replace $IntegrationServer_packages_locationwith the absolute path of Integration
Server packages.

Microservices Runtime

IfMicroservices Runtime launches using the startup script, configure the Java agent settings
in the Integration Server_directory/bin/setenv.bat(sh) file as follows:

PROFILER_ENABLED=false

JAVA_PROFILER_OPTS="-javaagent: $IntegrationServer_packages_location
/WmServiceMock/resources/int/utf-agent.jar=log=level=INFO".

Replace $IntegrationServer_packages_locationwith the absolute path of Integration
Server packages.

To run a test coverage analysis

1. In the webMethods Tests section, right click and select wM Code Coverage Tools.

2. Select one of the following:

Run Suite: executes the selected test suite.

Run Suite with Mocks disabled: executes the selected test suite with Mocks disabled.

Run Tests: executes the selected test case.

Run Tests with Mocks disabled: executes the selected test case with Mocks disabled.

The test or suite coverage analysis appear as a graphical data under the wM Code Coverage
view.

You can generate code coverage reports using the default maximum memory size specified in
Integration Server. This report effectively handles the Test Suite containing more number of lines
of code and test cases for a service. If a service comprises an exceptionally high number of lines
of code or tests executed in a single test execution session, Integration Server must upgrade the
default maximum memory size.

Viewing Code Coverage Analysis

After you run the test, wM Code Coverage view displays a detailed coverage report of the test
session.

The tested flow steps and map actions or Services appear in green and the untested flow steps
and map actions appear in red.

To view the code coverage analysis

1. On the wM Code Coverage view, perform one of the following:
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To..Click...

Represent elements under the corresponding Packages and Service
namespace. This Viewprovides detailed coverage analysis of the flow

Full Packages View

steps andmap actions of all the individual service(s) under test in the
test suite.

Represent only Invoked Services as elements under corresponding
Packages. This viewprovides the coverage analysis of only the services
invoked during the test case or test suite execution.

Service Level View

Exclude System Packages:

Hides all the Integration Server Core Packages from the Report.

Represent elements based on invocation hierarchy. ThisViewprovides
individual test coverage analysis of the flow steps and map actions
of the individual service(s) involved in the test case.

Execution Model View

Hides all the Integration Server Core Packages from the Report. This
option is selected by default and depends on Service Level View.

Exclude System
Packages

Displays full coverage details.Show All Entries

This is default selection.

Hides the untested parts of test coverageHide Missed Entries

This does not effect the Coverage percentage.

Hides the tested parts of test coverage.Hide Covered Entries

This does not effect the Coverage percentage.

Viewing Mock Event Details

After you run the test, wMCode Coverage view displays the details of all the mock events during
the test execution session. This view highlights the list of the mocked services, mock types, test
case name, and the result.

To view the mock event details

1. On the wM Code Coverage view, select the Mock Events View from the drop-down menu
item.

Note:

The Full Packages View and the Service Level View highlights the specific services
if pipeline, exception or factory type of mocking is detected. The views also show the
number of times a particular service is mocked.
The Execution Model View highlights the services that contains service type of the
mocking. Here, the view renders themock service details in the execution chain instead
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of the mocked service. The view also shows the details of the actual service that is
mocked.

Defining the Coverage Scope

Unit Test Framework allows you to edit and redefine the scope of a test coverage session. To
achieve this, you can edit an existing launch configuration or create one. You can select packages
that you want to include under the coverage purview. Flow elements and services belonging to
the selected packages determine the coverage percentage.

To create a launch configuration

1. In the webMethods Tests section, right click and select wM Code Coverage Tools.

2. Click Code Coverage Launch Configurations....

3. On the Code Coverage Launch Configurations box, select wM Code Coverage and click to
add a new launch configuration.

4. Enter a name in the Name field and a project name in Project field.

5. On the Test tab, enter the following information:

DescriptionField

Specifies the project name for..... You can click Browse... to select
from the

Project

Specifies the test suite path. You can click Search... to select from a
list of valid test suite files in the specified Project.

Test Suite

Optional. Specifies the test name. You can click Search... to fetch the
list of tests from the specified test suite. If this field is left blank, all
the tests are selected.

Test Method

6. On the Project Filter tab, perform the following

DescriptionField

Specifies the server node name. You can select theDefault server node
to list all the available packages from the server.

Server Node

Defines the scope of coverage analysis for the launch. You can select
the required packages from the list.

Profiler Scope

7. Click wM Code Coverage Tools.

The coverage analysis appear as a graphical data under the wM Code Coverage view.
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Coverage Analysis in Headless Mode

Test Suite Executor (see “Creating a Test Suite Executor” on page 51 ) provides the Ant build file
run-composite-runner.xmlwith necessary tasks and properties to start a test. Use the task
composite-runner-all-tests for headless test execution to generate code coverage analysis report.

Specify the following properties:

DescriptionName

Set to Coverage to generate coverage
report. Set to None for regular test
execution.

webMethods.test.setup.profile.mode

Specifies the list of comma separated target
Integration Server package names. This

webMethods.test.scope.packages

Defines the full scope for the coverage
analysis and percentage calculation.

Example:
SampleTestSuite,SampleTestSuite1

Set to true to generate the ExecutionModel
code coverage report.

webMethods.test.profile.result.includeExecutionModelReport

Set to false (default) to generate the regular
code coverage report.

Set to true to generate the Service Level
code coverage report.

webMethods.test.profile.result.includeServiceLevelReport

Set to false (default) to generate the regular
code coverage report.
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WmServiceMock Services

The services in the WmServiceMock package deal with the mocking aspects of testing. These
services provide a way to enable or disable mocks for individual services or server-wide.

wm.ps.serviceMock:loadMock

Sets up mocking for a service.

session, user, or server. The default is session.scopeInputs

The name of the service to be mocked. No validation is performed on the
name of the server or its existence.

service

The mockObject is an object type. The behavior of the mock is controlled
by the type of the actual object.

mockObject

The name of the
alternate service to

java.lang.StringInputs

mock the mocked
service with.

The exception to be
thrown for the
mocked service.

java.lang.Exception

The fixed pipeline to
return for themocked
service

com.wm.data.IData

The implementation
of the factory objects

com.wm.ps.serviceMock.MockDataFactory

that creates the
dynamic pipeline for
the mocked service.

Optional document containing all extra parameters for the alternate
service. This parameter is only needed when mocking a service with an
alternate service and the alternate service needs additional inputs.

parms

NoneOutputs

wm.ps.serviceMock:clearMock

Removes mocking for a service.

session, user or server. The default is session.scopeInputs

The name of the service to be mocked. No validation is performed on the
name of the server or its existence.

service
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wm.ps.serviceMock:clearMock

NoneOutputs

wm.ps.serviceMock:clearAllMocks

Removes mocking for all services.

NoneInputs

NoneOutputs

wm.ps.serviceMock:suspendMocks

Suspends mocking for all services.

NoneInputs

NoneOutputs

wm.ps.serviceMock:resumeMocks

Resumes mocking for all services, for which it was suspended.

NoneInputs

NoneOutputs

wm.ps.serviceMock:getMockedServices

Retrieves the list of services that are currently mocked in all the scopes.

NoneInputs

The list of services that are currently mocked in the session,
user, or server scope.

mockedServicesOutputs

References

Javadoc API Reference - The javadoc reference for the Test Suite java API. This is useful for
advanced Test Suite features as well as creating pure java unit tests for Integration Server
services.

JXPath– Documentation for JXPath API
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